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About Sputnik Agro

Sputnik Agro is a geographic information system for precision agriculture.

Sputnik Agro provides specialists with the necessary set of tools for solving problems of land inventory,
crop control and agrotechnical measures, land reclamation planning and risk management. The software
provides full-fledged workflow with raster maps in the multi-spectral range, digital elevation models and
vector maps.

2019 © Geoscan

www.geoscan.aero

Table of content: 1



CHAPTER1

System requirements

Minimum configuration:

• Windows 7, 8, 10 (64-bit), Linux (Mint, Ubuntu), Mac OS

• CPU: Intel Core i3

• 1 GB of disk space

• 4GB RAM

• Video card: Nvidia, AMD, Intel HD 4000 and newer, 1GB VRAM, OpenGL 2.1 support

Recommended configuration:

• Windows 7, 8, 10 (64-bit), Linux (Mint, Ubuntu), Mac OS

• CPU: Intel Core i5 / i7 and better

• 1 GB of disk space

• 8GB RAM

• Video card: Nvidia, AMD, 1GB VRAM, OpenGL 2.1 support

2



CHAPTER2

Instalation

Spuntik Agro is distributed for Windows operating systems. Follow the installation instructions for your
operating system to complete the installation.

2.1 Windows

1. Run Sputnik Agro installation package (administrator privileges are required).

2. Follow the onscreen intructions to complete the setup .

3. After installation is finished. KML and KMZ files will be associated with Sputnik Agro.

4. To start the application choose Start > Sputnik.

5. In case of issues during instalation process, read :doc: Errors_fixing chapter.

Attention: You need to have administrator privileges to install Sputnik Agro and license driver. In
Spuntik Agro is installed without administrator privileges, software may not work properly.

3



CHAPTER3

Activation

3.1 Online activation

To activate Sputnik Agro via Internet:

1. Make sure you have internet access

2. Start Sputnik Agro, use Activation… command fromHelpmenu

3. Paste your license key to Enter the product key input filed and click Activate

Important: In case activation is faild, first check if you pasting the key in right format, the format of key
shoul be: XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX

3.2 Offline activation

Important: You need to use additional PC with Internet access to activate Sputnik Agro on PC without
Internet access.

To activate Sputnik Agro on PC without Internet access:

1. Download offline activation utility

2. Start RUS utility on PC with Sputnik Agro installed. In the Collect Status Information tab check
Installation of newprotection key option and clickCollect information button. In theCollect
information dialog box, set the name and path to save *.c2v file.

3. Start web-browser on PC with Internet access and open the link

4. Login in to Activation service using your license key a password

5. SelectOffline Activation option.

4
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6. Upload *.c2v file and click Generate button, *.v2c file will be generated.

7. On PC with Sputnik Agro installed open RUC utility. In the Apply License File tab select *.v2c file
and click Apply license button.

3.3 Activation in case of OS reinstalling

To activate Sputnik Agro in case of OS reinstalling follow the list of instructions bellow:

1. First you need to get *.v2c key. To get it open https://license.geoscan.aero in your web browser and
use your license key as login.

2. On the user registration page fill the information or click Register later

3. Click View button in the Previous Activationmenu.

4. In the generated keysmenu click V2C File. It will be downloaded.

5. Open http://localhost:1947/_int_/checkin.html in your web-browser, select you *.v2c file and click
Apply button.

3.3. Activation in case of OS reinstalling 5
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CHAPTER4

User Interface

4.1 GUI

Spuntik Agro GUI consists of:

• Main menu

• Toolbar

• Layers and objects window

• Properties window

• Map window

• Background jobs window

6
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4.2 Hotkeys

Action Hotkey
Open file Ctrl +O
Undo Ctrl + Z
Redo Ctrl + Y
Delete Delete
Select all Ctrl + A
Clear selection Ctrl +D
Fullscreen F11
Rectangular selection Ctrl + R
Reset view to northup N
Reset angle totop-down view and rotate map to north-up viewр R

4.2. Hotkeys 7



CHAPTER5

Navigation

Scaling (zoom in/zoom out)

Moving (globe rotation around its center)

Clockwise / Counterclockwise rotation (globe rotation around the point on its surface)

Changing the vertical angle of the view (globe rotation around the point on its surface)

8
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Inspecting high-altitude objects (Moving along high object)

9



CHAPTER6

Project

Workingwith different datasets can be simplified by switching between Sputnik Agro projects. Every project
automatically stores a set of parameters:

• A list of maps and drawings, loaded by the user;

• Last position of the 3D Map window camera;

• Location, visibility and size of UI objects.

6.1 Projects management

To create new project choose Project command fromNew submenu of Filemenu.

To open existing project choose Project command fromOpen submenu of Filemenu.

To open recent project choose one of available projects from Recent projects submenu of Filemenu.

To import any type of data into the project choose File command fromOpen submenu of the Filemenu.

6.2 Additional information

By default raster imported raster maps are aligned with default SRTM elevation model. SRTM terrain data
has 90 m spatial resolution and vertical accuracy about 1 m. Level of details can be increased by loading а
local DEM.

10
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Data at the bottom of the Layers and Objects list display above the layers at top.

Use checkboxes in the Layers and Objects list to turn layers visibility on and off.

6.2. Additional information 11



CHAPTER7

Data sources

7.1 Raster maps

Sputnik Agro supports the following raster map extensions: *.tiff, *.ecw, *.jpg, *.kmz and elevation models
extensions:*.tiff and *.kmz. Read more about working with raster map in chapter Raster maps tools

7.2 Vector maps

Sputnik Agro supports the following raster map formats: *.shp and *.kml. Read more about working with
*.kml in chapter KML tools, about working with *.shp in chapter Shapefiles tools.

7.3 Drawings

Spuntik Agro support drawings in *.dxf format. It is not available to import *.dxf file into project as a map
layers and view it in theMapwindow. You can view *.dxf files in 2DDrawings viewer . Read more about
working with *.dxf in chapter Drawings tools.

7.4 WMS/WMTS services

Sputnik Agro support importing data from WMS and WMTS services with feature request option. Read
more about working with WMS/WMTS services in chapterWMS.WMTS_tools.

7.5 Aerial survey

Spuntik Agro have number of tools for working with aerial imagery and UAV telemetry data:

12
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• Visualisation of aerial survey telemetry in theMap window

• Viewing images

• Projecting aerial images on map

You need to have aerial survey telemetry file in *.txt format to be able to analyze it. Readmore about working
with survey in chapterWorking with UAV telemetry files.

7.5. Aerial survey 13



CHAPTER8

Measurement tools

8.1 Ruler

Ruler tool displays distance between two points on surface.

To measure distance with Ruler click left on icon in the toolbar, then select two points on the surface

to measure the distance between them. Or select existing line and click left on icon in the toolbar to
measure its length.

It is possible to change theposition of the selected point. Click once left at a point, then drag it by the surface.

When length for polygon is measured, its value saves to polygon extended data, you can use Information
tool to display the volume value when you need.

8.2 Corner ruler

Corner ruler tool displays slope, horizontal distance, actual distance and elevation between two points
located on surface.

14



Sputnik Agro
user manual, Release 1.4

To perform measurements with Corner ruler click left on icon in the toolbar, then select two points
on the surface to perform measurements.

8.3 Area

Area tool displays surface area of a polygon on surface.

To measure area of polygon click left on icon in the toolbar and draw a polygon. Or select existing

polygon and click left on icon in the toolbar.

Important: Depending on the area measured,the result can be displayed in square meters, hectares or
square kilometers. Area can be calculated on a plane or DEM surface.

When area of polygon is measured, its value saves to polygon extended data, you can use Information
tool to display the area value when you need.

8.4 Volume

Volume tool calculates the volume of an area of DEM.

To calculate volume click left on icon in the toolbar and draw a polygon. Or select existing polygon and
click left on icon in the toolbar.

8.3. Area 15
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Important: In case there is only one DEM in the Layers and Objects list, Sputnik Agro use that DEM for
measurements. Otherwise it is necessary to drag and drop selected DEM from Maps folder toMeasure-
ments > Volume object.

When volum for polygon is measured, its value saves to polygon extended data, you can use Information
tool to display the volume value when you need.

8.5 Volume difference

Volumedifference tool calculates the difference between twoDEMsof the similar area, capturedwith
a time interval. It is possible to calculate cut and fill volumes and highlight the areas that have changed.

To calculate volume difference between two DEMs click on the icon on the toolbar and then draw a
polygon tomeasure the volume difference. Select Initial DEM and final DEM bymoving it fromMaps folder
toMeasurements > Volume difference.

Some parameters can be set before the calculation begins:

• Difference threshold (altitude difference between one point of two different DEMs to be included into
calculation);

• Calculation step or turn «best» on.

The less the values of the calculation step and the difference theshold, the more time needed to finish the
calculation. Press Calculate button when setup is finished. After calculation is finished you can see the
result in the Fill and Cut fields in the Properties window.

16 Chapter 8. Measurement tools
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When volume difference for polygon is measured, its value saves to polygon extended data, you can use
Information tool to display the volume value when you need.

8.5. Volume difference 17



CHAPTER9

Crop inspection and analysis

9.1 Prescription generation

Open NDVI orthophoto , click right mouse button on it and select Display as NDVI.

To calculate NDVI values for area of your interest, select Tools > NDVI calculation. Select area of your
interest with polygon. After that, you could see the histogram of NDVI values for your area. You can export
histogram data to *.txt file if you need.

18
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Then setup network parameters and clickCreate. Setup attribute name for output *.shp file, you can change
class ranges moving the sliders on histogram, and press Vectorize.

9.2 Raster calculator

The satellite agro implemented Raster calculator, which provides pixel-by-pixel execution of math-
ematical operations on raster datasets. To work with the Raster calculator, in the Layers and features
window, select the raster to edit and run Tools > Raster calculator.

9.2. Raster calculator 19
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Both manual and graphical introduction of formulas for calculation are available in the tool dialog. In the
section Input channels- displays the number of channels that has the selected image. The expression is
specified in the Output channels section, color indicator, in the Check column, whether the expression
is correctly written (green) or not (red). To add or remove expressions, click the appropriate buttons. In
Sputnik Agro You can set the output data type (Source, Int, Float). For faster processing, enable checkbox -
Optimize to speed up.

9.3 Couting sunflowers

The Sputnik Agro is available to perform the Couting sunflowers in automatic mode and save the
result in formats *.tif, *.xls. Run the Tools > Calculation of sunflowers. In theMaps window, specify
the search area. In the Properties window, specify the orthophoto by which to search. Specify which files
to generate with the results by enabling the checkbox in the appropriate formats:

• in the format.*tif will be saved to the visual component, I found the sunflowers in the form of point
objects;

• in the file format *.xls will form a table with numeric values.

To perform calculations, press Calculate…. In the dialog box that appears Select calculation param-
eters set search Threshold and click OK. The Map window displays the result of the found objects,
Number is shown in the Properties window.

20 Chapter 9. Crop inspection and analysis
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9.4 Calculate trees

Calculate trees can automatically search for trees and export the results in *.kmz formats. As the source
data, you will need a digital surface model (DSM) and a digital elevation model (DEM).

Select Calculate trees from the main menu Tools. In the Maps window, select the area to search for
trees. In the Properties window, specify the path to the DSM and DEM files. In section Tool settings
specify:

• Crown diameter;

• The step with which the algorithm will perform the search;

• Minimum height.

Press Search to start the algorithm. In the dialog box, specify the name and path to the file with the result.
In theMaps window, the result will be displayed, the found trees will be displayed as point objects.

9.4. Calculate trees 21
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9.5 Processing of RAW multispectral remotely sensed data

Sputnik Agro allows to preprocess RAWmultispectral aerial photography, for further photogrammetric pro-
cessing. Software supports the preprocessing of data obtained using:

• UAV Geoscan 201 Agro / Agrogeodesy

• UAVs equipped with a GITUP G3 DUO NDVI multispectral camera

Select File > Import > Arial photography and choose directory with photos and *.txt file with coordi-
nates.

If you need to process all photos, click right mouse button on Arial photos object and select NDVI converter.
If you need to process photos in the area of your interest, select it with polygon, click right mouse button on
photo icon and select NDVI converter.

Next, setup the output channels, for NDVI orthophoto false RGB and NDVI channels combination recom-
mended, and select calibration plate to setup calibration coefficient. Press OK to start the processing.

Availabel output channels:

• False RGB – Appropriate for aligning, photorealistic image. Three channels,

• 16 bits TIFF NDVI – Inappropriate for aligning, should be used along with false RGB channel. One
channel, 8 bits TIFF

• RNDVINIR –Appropriate for aligning, inappropriate for export toGeoTIFF. Three channels, 16-bits
TIFF. Can be used for export to KML.

22 Chapter 9. Crop inspection and analysis



CHAPTER10

Reclamation planning

10.1 Slope map

Slope map tool allows to calculate slope map for given area on DEM.

To start slope map calculation choose tool from Tools menu and draw the polygon to calculate the
slope map within it. In the Properties window set up color palette for the slope map and click Calculate
button. In the Calculate slope maps window select elevation model to calculate slope maps for, names
and formats for the output and click OK

23
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Note: It is posible to change default slope map color palette, to do that choose Preferences command
fromSettingsmenu, in thePreferenceswindow switch toSlopemap tab and set the default color palette
parameters.

10.2 Waterflow calculating

Tool Waterflow calculating calculates water drain lines and water basins areas using DEM. Select
Tools >Waterflow calculating. Select area of your interest, using polygon.

Setup type and parameters of calculation, click Calculate. Select DEM layer for the area of your interest
and clickOK. Calculation result, will be represented as vector *.shp layer for «water flows» and represented
as raster *.tiff layer for «fill areas»

24 Chapter 10. Reclamation planning



CHAPTER11

Surveying

11.1 Contour lines

Contour lines allows to calculate contour lines for given area on DEM.

To start conctour lines calculation choose tool from Toolsmenu and deliniate area to calculate contour
lines within it. Set upContour interval andDEMresolution in thePropertieswindow and clickCalculate
button.

25
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11.2 Cross section

Cross section allows to generate cross section for given baseline in *.dxf fromat.

To start cross section generation choose tool from Sections submenu of Toolsmenu and draw a base-
line. Set up Calculation step and Altitude mode in the Properties window and click Calculate button. In
the Save dialog box select the name and directory to save the output and format and click Save button. It
is available to generate cross section in *.dxf, *.csv and *.txt formats.

After section generation is finished it will be displayed in theDrawing viewer window.

11.3 Cross sections

Cross sections allows to generate custom set of cross sections perpendicular to given baseline and
aligned to the left and to the right of the baseline by half of the section width value.

To start cross sections generation choose tool from Section submenu of Toolsmenu and draw a base-
line. Set up Calculation step, Distance between the sections, Section width and Altitude mode in the Prop-
erties window and click Calculate button. In the Save dialog box set up the name and directory to save
the output and format and click Save button. It is available to generate cross sections in *.dxf, *.csv and
*.txt formats.

26 Chapter 11. Surveying
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11.4 Section comparing

Compare sections and Compare cross sections tools allows to generate cross section or set of
cross sections for multiple DEMs on one *.dxf drawing.

To start sections comparing choose one available section comparing tools from Sections submenu of tools
menu and draw a baseline. Set up parameters in the Properties window and click Calculate button. In
theCalculate sections for elevatonmodelswindow select elevation model to calculate sections for, set
up the name and directory to save the output and format.
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11.5 Kriging interpolation

Kriging interpolation allows to build elevation model from given set of points.

To start building elevation model choose tool from Toolsmenu and draw a polygon to build elevation
model within it. Import *.kml file with points into Sputnik Agro and drag it fromMaps folder intoKriging
interpolation node. In the Properties window set up the Variogram model and other parameters if
needed, click Calculate button.

In case you have points coordinates in *.txt file, create empty polyline, right-click on and choose Edit co-
ordinates.. command. In the Edit coordinates window select coordinates reference system and paste
coordinates from *.txt file. To create points from polyline, right-click on it and choose Create points..
command.
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Important: Keep inmind that vertical datum, used for altitudemeasurements in *.kml files is theWGS84
EGM96 Geoid.

11.6 Relief editor

Relief editor tool allows to edit elevation models. Relief editor tool may be used to build DEM from
DSM by deleting buildings and other objects, the other usage scenario is to model new surface features.

To start relief editing choose command from from Edit relief submenu of Toolsmenu. Now you can
draw polygons to delineate relief feature you want to modify. Double click to finish polygon drawing and

start to draw the next one. To finish polygon drawing click button on the toolbar or pressEnter button.

In case you need to delete features from surface - just delineate them with polygons, the part of elevation
model within given polygons will be interpolated with respect to polygons node.

In case you need to model new surface feature - draw it as polygon and set the needed elevation for each
polygon node using Coordinates editor.

Before starting calculation choose if you want to edit current file or create a copy of it and click Calculate
button.
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Presentation

12.1 Screenshot

Screenshot tool allows to create high resolution screenshots of 3Dmodels and other data imported into
the project.

To create screenshot choose one of available resolutions orCustom size command from Screenshot sub-
menu of the Viewmenu. To take screenshot click Take Screenshot button in theMap window.
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12.2 Video tour

Tour tool allows to create video tour around the 3D model, or other data imported into the project,

and render it in high resolution. To start video tour creation click icon on the toolbar. You can change
key position parameters and delay parameters in the Properties window. Location of key position can be
changed in theMapwindow, to do that drag key position node in theMapwindow. To change key position
altitude, press Shift button and drag it.

To play video tour use and buttons on the toolbar. To render a video from video tour right-click
the tour in the Layers and objects window and choose Video recording… command. In the Video
settings window set rendering parameters and click Record… button.
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Special tool

13.1 Creating a Grid

The Grid tool is used to create a regular grid with indexed cells.

To create a grid in the Layers and objectswindow, select *.kml file containing a polygon bounding region
for the grid. SelectCreate grid from Toolsmenu. In the dialog box, set the grid size in kilometers. Specify
the path to save the result and pressOK.
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Note: To select several squares from the grid, hold down the Ctlr key and then click the square in the grid
one by one.

13.2 Camera-antenna correction

The program Sputnik Agro the ability to correct the distance between the antenna and the onboard GPS
receiver UAV. For correction, add a text document with the coordinates of the photo centers. In the Tools
section, select Camera-antenna correction. Camera-antenna correction is also available in the context
menu of the file. In theMap window that appears, specify the necessary correction parameters.

Important: the Suffix is added automatically by the program, if it does not appear, use _corrected.

13.3 Align maps

In the Sputnik Agro program, a tool for Align maps relative to each other is implemented. You need
to load orthophotos into theMap window. In the Toolsmenu, select Align maps.

In the Layers and objects window, click one of the orthophotos, then select a point on theMap and click
the left mouse button, a marker in the form of a red point appears, select the corresponding point on the
second orthophotos. After that, the shift of the second card will be calculated and it will be shifted to the
required distance.
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Note: You can shift the orthophoto in thePropertieswindowof the selected orthophoto. Shift parameters
can be set: by height, by direction (South-North and West-East).
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Working with Altum, Sequoia and RedEdge cameras

For multiband rasters obtained by photogrammetric processing of data from Altum, Sequoia and RedEdge
cameras, visualization presets are available.

There are several types of raster display for each camera:

Camera type Raster display modes
Sequoia CIR, NDVI, NDRE
RedEdge RGB, CIR, NDVI, NDRE
Altum CIR, NDVI, NDRE

In the Visualization tab, You can set the camera type by selecting the appropriate option from the drop-
down list. To display the image according to the selected camera format, press Apply.

In the context menu of the raster in the Layers and objectswindow, select Show as and according to the
camera type, the options described above will be offered.
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Raster maps tools

15.1 Optimisation and re-projection

To speed up the rendering of raster maps in *.tiff format needs to optimize them. In some cases you may
need also to reproject raster map into other coordinate reference system.

To optimse or reproject raster map choseRaster map command from Import submenu of Filemenu. In
Import rastermapwindow select the raster or several rasters and clickNext button. Check theOptimize
box for optimisation. To reproject raster map into other coordinate system double click on it, in the Coor-
dinate systems window select one of available coordinate systems and click OK button. To finish import
procedure, click OK button.

15.2 Visualistaion

Sputnik Agro provides several visualisation modes for raster maps: single band, multiband, color palette.
Default visualisation mode depends on raster map type:

Map type Number of chan-
nels

Stored value
type

The default display

Multispectral images > 3 int the image in the natural or pseudo
color

RGB raster maps 3 int the image in the natural color
Height map
(DEM/DSM)

1 float relief

Other single-band
rasters

1 float relief

Other single-band
rasters

1 int monochrome image
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To change raster map visualisation mode click Additional properties in the Properties window. In the
Additional properties window switch to Visualisation tab and set up visualisation mode.

The program supports pre-configured visualization modes of Altum, Sequoia and Red Edge multispectral
cameras. For more information, seeWorking with Altum, Sequoia and RedEdge cameras

15.2.1 Single band mode

Single bandmode is a default mode for 1 or 2 bands rastermaps. Youmay set upwich bandwill be visualised
in theMap window.

This mode is the defaultmode for displaying single-band rasters when file loaded into the program.

To switch to this mode, in the drop-down listVisualizationmode select Single-Channel. In this mode,
You can set the Max and Min thresholds of values to display.

Important: This mode can also be used to display a single channel of a multiband raster.

15.2.2 Multyband mode

Multiband mode is a default mode for 3 or > 3 bands raster maps. You may set up wich bands will be
interpreted as Red, Green, Blue bands and visualise raster map in pseudo color mode.

To switch to this mode, in the drop-down list Visualization mode selectMulti-Bands.

15.2.3 Palettes

Palettes is not a default visualisation mode for any type of raster map. Youmay use it with any type of raster
map to style one of its bands.

There are three palette-setting mode in Sputnik Agro:

• Stretch

Set band, color scheme and additional parameters and click OK button to finish.To set off the palette
right-click raster map in the Layers and objects window and choseDefualt command from Show
asmenu.
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• Classify

Select band, number of classes and color scheme. Set additional parameters and click OK button to
finish. Check Relative box to translate the raster values to relative mode (from 0 to 1). If raster has a
float type values, it will be interpreted as elevationmodel. CheckHide elevation box to interpret raster
map as image.

• Templates

You can create or load templates. To create templates, click Table and select Add to templates….
The file will be added to the list of existing templates.

To load palette in the Template section, select Load… from the context menu. The added palette
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can be edited and saved to a new file. Select the Save as… in the context menu of the section Table.
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KML tools

16.1 Geometry creation

Sputnik Agro allows to perform basic edit operations for *.kml files. To create new *.kml file choose KML
command fromNew submenu of Filemenu.

New *.kml file will be opened in edit mode. When edit mode for *.kml file activated a set of specific tools
appears in the toolbar:

Icon Tool

Create Point

Create line

Create ring

Create polygon

16.2 Editing

To open *.kml in editmode select it in theLayers andobjectswindow and chooseOpeneditor command
from context menu.

To edit geomtry node, click left mouse button on it in theMap window and drag.
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To edit coordintes of geometry manualy, select it and choose Edit coordinates.. command from context
menu.

In Edit coordinate dialog box it is available to:

• change separated node coordinates

• set the elevation for all geometry nodes

• set the coordinate represetation mode

16.3 Style

To configure geometry style, select it in the Layers and objects window and cnofigure style properties in
the Properties window.

When several geometries are selected, you can configure common style for all selected geometries.

When folder or multigeometry is selected, you can configure common style for all geometries inside folder
or multigeometry.

16.4 Geometry visualisation properties

Sputnik Agro tools allow to draw 2D and 3D geomerty objects.

Three altitude modes for geometries are available:

• clampToGround / clampToSeaFloor;

• relativeToGround / relativeToSeaFloor ;

• absolute.
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Default mode for geometry objects is clampToGround.

Example: clampToGround mode

Example: relativeToGround mode

Example: absolute mode

44 Chapter 16. KML tools



Sputnik Agro
user manual, Release 1.4

To create 3D geometry objects (only available in absolute or relativeToGround mode) switch extrude mode.
To switch extrude mode of geometry object, choose Change extrude property in its context menu.

16.5 Geometry operation

Sputnik Agro has a wide range of tools to convert between different types of geometry and perform boolean
operations on two or more polygons.
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Select two or more polygons in the Layers and Objects window or in the 3D map window, then call the
context menu by clicking right mouse button. You can perform the following operations:

Union – polygons dissolve into one polygon or, if there are no common points, become a multigeometry
feature. Intersect - only the common points are copied to the resulting polygon(s). Difference – the common
points of the polygon(s) are subtracted from the first selected polygon. Symmetrical difference – only the
non-common points are copied to the resulting polygon(s).

It is possible to transform geometry objects from one type to another:

from point from lines from ring from polygon
Create points + + +
Create line + - -
Create ring + + -
Create polygon + + +

To transform geometry objects form one type to another, select two or more objects in the Layers and
Objects window and choose one of available transformations in its context menu.

To create buffer, select geometry and choose Create buffer command from its context menu.

16.6 Export

It is available to export *.kml file into *.dxf and *.shp formats for futher usage in GIS and CAD applications.
To export *.kml file to *.dxf or *.shp choose Save as command from its context menu. In the Save dialog
box select name, format, and directory for output file. You can use *.prj file to set custom CRS for the output
*.dxf or *.shp file file.

When you export *.kml file containing more than one geometry type into *.shp fromat, select geometry
types you would like to export. Each geometry type will be exported in separated *.shp file. You can create
dictionary for attributes names. Click settings in the Export Kml to ShapeFile dialog box, set up names
for output attributes in the Conformity column and click Save dictionary. To use the dictionary created
earlier, click Apply dictionary.
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Shapefiles tools

Sputnik Agro support importing and visualisation of *.shp file and exporting *.kml files into *.shp format.
Know more about exporting *.kml file into *.shp in KML tools chapter. To open *.shp select File > Open
> File…. In the dialog box, specify the file type -*.shp. The file appears in theMap window.

17.1 Viewing attributes

To view *.shp file table of attributes right-click it and choose Show attributes. To switch between pages
of attributes table use Previous andNext buttons.
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17.2 Setting styles

To set up styles for *.shp file, right-click it and choose Shapes style… command. In the Shapes style…
window you may apply *.sld file to *.shp file. To apply *.sld file rightc-click on *.shp file in the Layers and
objects window and choose Shapes style.., in the Styles window click Apply SLD… button and select
proper *.sld.

To change style for condition, double-click on it in the Styles window and set up new style in the Style
editor window. To save new *.sld file, use Save as SLD button in the Styles window.

Note that the format specification is *.shp implies strict typing of the file by geometry type, different styles
are applied to different types of layers:

Layers Available style Available style Available style
Points Marker thickness Marker color •

Lines Line thickness Line color •

Lines Stroke thinckness Stroke color Fill color

48 Chapter 17. Shapefiles tools



CHAPTER18

Drawings tools

Spuntik Agro support generation of *.dxf files and it’s visualisation in 2DDrawing viewer.

You can export to *.dxf format any *.kml file, also such tools as: sections, cross sections, compare sections,
TIN model create output in *.dxf format. To import *.dxf into Sputnik Agro choose File command from
Open submenu of Filemenu. To open drawing in Drawing viewer double left-click on it in the Layers
and objects window.

You can perform measurements inDrawing viewer using corner ruller .
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WMS/WMTS services

WMS - Web Map Service

WMTS - Web Map Tile Service

To import WMS or WMTS map chooseWMS/WMTS.. command from Import submenu of File menu.
In the ImportWebMap dialog box set up the url andAuthentication parameters if needed and clickNext
button. Than select needed layers and click Finish button.

It is available to get feature info from WMS/WMTS maps imported. To do that use tool on interested
feature.

Due toWMTS support, you can use your own tile surfaces, createdwithMapbox service. To sue yourMapbox
tile surface, copy its link and paste it to URL-string inWebmap import window.
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Working with UAV telemetry files

20.1 Aerial survey

Sputnik Agro provides number of tools for aerial survey raw data analysis. To work with raw aerial survey
data you need to have images and *.txt file containing UAV telemetry in one folder. Image coordinates
should be in WGS 84 CRS.

To start woking with aerial survey choose File command from Open submenu of File menu and select
telemetry file in *.txt, *.tel.
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20.2 Agisoft Photoscan/Metashape project creation

To create Agisoft Metashape project from aerial survey raw data right-click telemetry file in theLayers and
objects window and choose Create Photoscan project.

20.2. Agisoft Photoscan/Metashape project creation 53



CHAPTER21

Coordinate reference systems

In Sputnik Agro it is available to set up coordinate reference system for current project. All data in the project
transformes to project coordinate reference system on the fly.

To set up project coordinate reference system choose one from Coordinate system submenu of the Set-
tingsmenu. To set up custom CRS, choose Custom CRS command from Coordinate system submenu
of the Settingsmenu. In Choose CRS dialog box, choose one of available CRS and click OK. To add cus-
tom CRS to the list of available CRS, click Load new PRG button, in the Load new PRJ file dialog box
select file and set CRS name, click OK.

Note: If you import raster map without CRS information in it’s metadata, or in case CRS information in
metadata is wrong you can set CRS for raster mapmanualy in it’s proprties window. InPropertieswindow
click Additional properties button, in dialog box switch to the Coordinate system tab and set up CRS
for raster map.
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Preferences

Select Settings > Preferences in mainmenu. In this window, you can configure a number of user param-
eters to improve the interaction with the program.

Parameters Descriptions
Cache is a folder for temporary data in the file system
Coordinate Sys-
tems
DXF this page is for configuring DXF vector images (*.dxf)
Error Reporting setting up error reporting
Interface general interface settings. Setup single object dragging and location format
KML setting up creation, viewing and working with *.kml files
NDVI NDVI tools settings; set the default palette for viewing NDVI maps; Shapefile cre-

ation
Photo projections setting the display of photo
Slope map set the default palette for the draft Map tool
TLS perfomance adjust the balance between performance and display quality *.tls models
Tables tables settings
Tools this page is for configuring tools
Usage reporting enable/disable the usage reporting of the Software
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Troubleshooting

23.1 Installation errors

The most probable cause of errors that appear during Sputnik Agro installation is a lack of administrator
privileges.

In case the error appears:

1. Abort the installation

2. Check whether you have sufficient level of administrator privileges

3. Run installation again

23.2 Startup errors

Startup errors occur because of licencing issues.

Follow these steps:

1. Checkwhether hardware key (USBdongle) is installed properly on the local PC or on the Licence Server

2. In case software key is used, check if the HASP driver is installed properly

Read more about license driver issues in chapter Administration.

23.3 Runtime errors

Two types of errors can occur during runtime:

1. Handled exceptons appear in the bottom right part of 3D Map window;

2. Unhandled exceptions appear in a separate window.

56



Sputnik Agro
user manual, Release 1.4

In case of handled exception occur the masage box with instructions will appear in the bottom right part of
Map window.

In this of unhandled exceptions, please click on Send report button and write a short message to describe a
sequence of actions performed before the error has appeared. It will take some time to analyze your report
and to update Sputnik Agro.

Important: You also can setup automated report sending or disable it. Go to Settings > Preferences…
enter contact information and select one of available options for error reporting.

We appreciate your help. You are helping us to make Sputnik Agro perfect!
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Administration

To configure advanced parameters of Sputnik Agro you need to configure Sputnik.ini file manualy. The
default path to Sputnik.ini file is: C:\Program Files\GeoScan\Sputnik.

Important: You need to have admin privileges to edit Sputnik.ini file

24.1 Language set up

To change Sputnik Agro GUI language from English to Russian you need to configure Sputnik.ini configu-
ration file.

Open Sputnik.ini file using any text editor and change -nl key value from en to ru, save Sputnik.ini file and
restart Sputnik Agro.

24.2 Setting up proxy server

To configure the proxy (for instance, proxy IP address - 127.0.0.1, port - 8080, login - someUserName,
password - somePassword) add the following keys:

• Dhttp.proxyHost=127.0.0.1

• Dhttp.proxyPort=8080

• Dhttp.proxyUser=someUserName

• Dhttp.proxyPassword=somePassword
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24.3 HASP driver check and mainteinance

Sputnik Agro uses Sentinel driver as a license manager.

To check if the driver works properly open the browser and open the link: http://localhost:1947

If

Products page contains the list of the installed Sputnik Agro versions, Features page contains the full list of
available license keys and their restrictions (for trial keys).

If the link (http://localhost:1947) does not open, please install the driver again:

• Check whether you have an administrator privileges

• Open the installation folder, the default location is: C:Program FilesGeoScanSputnik

• Find and open «hasp» folder

• Press Shift and click the right mouse button. Select «Open Command Window Here» in the context
menu.

• Enter haspdinst.exe -i -kp –fss into the Command Window and press Enter

After installation is complete, check the link (http://localhost:1947) again.
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CHAPTER25

Changelog

25.1 Sputnik Agro version 1.4

25.1.1 New features

• EPSG CRS base

• User defined CRS support

• Relief edittor

• Track animation

• *.shp files support

• Raster calculator

• Multiband raster support

• Band blending for multiband rasters

• Visualiation presets for Altum, Sequoia and RedEdge cameras

25.1.2 Improvements

• Ability to add intermediate edges to polygons/polylines

• GUI for animated tours

• New GUI for *.kml

• Imporved raster maps import master
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25.1.3 Bugfixes

• No reloading while moving layers between folders

• Coordinate system parameters are read from file metadata

• The key combination CTRL + A (selection of all objects), works in all text boxes

• Fixed errors arising from the construction of isohyps

• All generated * dxf files are read in AutoCAD and other CAD systems.

• The sky is correctly displayed on the screeshots and rendered videos

• Files with an uppercase extension supported

• There is no error in the absence of access to the project layers

• The trajectory of the animated tour smoothes correctly
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